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Step Two: Working with Palettes 
 
Palettes are the method to customize writing activities for any student. 
They act as a group of buttons on a toolbar. A palette can be created with 
one or more items. The buttons provide a variety of actions, from reading 
directions, to changing the color of the text to branching to a new palette. 
You can use more than one palette at a time in a chosen screen location. They 
can be turned on and off as needed. 
 
Each item (or button) consists of 3 parts: 

1. item name 
2. picture 
3. one or more actions 

 
Actions are what give power to the items; to determine what happens when 
an item is selected (by clicking on it, using an overlay or switch). For 
extended use or use by a group a palette or group of palettes can be saved 
as a template activity. 
 
Step Two will address: 
 Selecting + using palettes  
 Creating an Overlay  
 Creating a new palette 
 add items from Item Library 
 modifying items + palettes 

 Editing palettes and items 
 Activity Templates 
 Locked Text and Answer Fields 
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USING THE PALETTE LIBRARY 
 
IntelliTalk II includes a library of palettes that 
can be used in any combination in any document.  
 Open a New document. Select Blank IT II 
 From the Create menu, select Edit Palettes 
 The Palette window appears 

 
 Standard palettes that cannot be removed  

are in italics. As a toolbar is  
selected, it's items are previewed.  
Scroll through  the various toolbars,  
select one you want to add to a  
document and click Add>>.  

 Select the Colors Toolbar. A student may  
use this in an activity where parts of speech  
are defined by color. 

 
 In the Add Palette to Document 

window, select where onscreen you want 
the palette to appear and click OK. The 
palette will appear in the list box 
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 You will see the palette appear on the current 
 document.  
 

 Experiment by adding several palettes 
to your document. See how their 
placement effects the document 
appearance and use. 

 
 
CREATING A NEW TOOLBAR PALETTE  
 
You may want to create your own palette or edit an existing one. A palette 
can be designed to be used as a standard navigation toolbar for writing 
activities or include subject specific items for a content activity such as 
dinosaurs or a combination of both! You will have an opportunity to create 
both kinds. 
 
First Writer Palette 
We will create a new toolbar that provides items that 
may enhance the writing process for a beginner 
writer. 
 In the Create menu, select Edit Palettes. In the 

Palettes window, select New Palette and name it 
"First Writer".  

 Highlight the palette name and select Edit Palette. 
 
 
 In the Edit Palette contents window, select the  

Tool Bar Items category from the Item Library.  
We will create our new palette with these items. 

 Scroll down until you see "New" (for new file). Click  
Add>> to add it to the palette. 

 For this palette, select the following items to be  
added:  

New    Open    Undo 
Save    Spell Check           Delete Sentence  
Print   Picture Library      Delete Word 
Speak word  Speak sentence     Speak all 
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REORDERING ITEMS IN A PALETTE 
 
 You will notice that as you add items to the palette  

they appear immediately in the document. After all  
of the items are added you may want to put them in  
a different order. 
 

 To reorder the items, first decide how you want the 
palette to look. Click on the item you want to move 
and then select either Up or Down to move it one 
place at a time. Again, the changes will be seen 
instantly on the document's palette. 

 
 When you have all the items in the correct order, 

click OK. 
 
SAVING AS A TEMPLATE 
 
You may want to save the document with the First Writer palette as a 
toolbar template to be used for a New Writing Document.  
 In the File menu, click Save As and open the Template folder. 
 Give the template a name: First Writer 
 In the Subject Area, select Blank Documents. This is where you store 

basic toolbar templates. 
 Click Save. 
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ACTIVITY 
1. Create another palette for a student learning to format a document to 

enhance the writing process. Include only new, save, print, read all, delete 
all and text format options. 

a. Identify which items should be included; should they be on the 
same palette or 2 different ones? 

 
2. Edit the Standard Activity Toolbar to include only the top row of items. 

Save it as Simple Activity Toolbar. 
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CREATING AN ACTIVITY PALETTE 
 
Palettes can be used for specific content activities making it possible for 
students to participate independently. We will make 2 related activities. 
Let's first create an exploratory activity called Good Food where students 
can select a picture of either a fruit or vegetable and learn about it. In a 
related activity, we will set up a fill-in-the-blank activity that illustrates 
what they learned. 
 
 Create a new blank document. In the 

Create menu, select Edit Palettes. In the 
Palettes window, select New Palette and 
name it "Good Food".  

 
 Place it at the top of the document. Click 

OK.  
 
 In the Edit Palette Contents window,  

select the Food category from the  
Item Library. 
 

 Find the apple. Click Add>> to move it to 
the new item area.  

 
 Select and Add 4 fruits and 4 vegetables 

and the salad item. Arrange them so that 
the fruits and veggies are randomly placed 
with the salad at the end of the palette. 

 
 Select the first item and click Edit 

Item. In the Edit item window the 
picture of the apple appears. Click on 
Actions where we will identify what 
happens when the apple item is selected. 

 
 IT II automatically includes "Insert 

Item" which causes the text or picture 
associated with apple to be placed in the 
document.  
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 Select the actions you want to view by  
selecting the general type in the list box.  
The choices in each category will appear  
in the box on the right. For this activity,  
select "Typing" and then add "type text..." 

 
 In the text box type: "Apples are fruit that  

grow on trees. They can be sweet or sour  
and red or yellow." This is the text that will  
be read when the apple is selected. Make sure  
to include punctuation to indicate the end of  
the sentence. We will set the read text  
options from the document window. 
 

 Click OK and select the next item. For each item  
ADD Type Text and include its name, whether it  
is a fruit or vegetable and something else about them. 
 

 
EDIT PALETTE APPEARANCE  
 
 In the Edit Contents window, select 

Palette Appearance. The features here 
are similar to those in the Item 
Appearance window. The difference is that 
changes are made to the entire palette. 
The Layout Tab is unique to the Palette 
Appearance; here you make choices on the 
overall size of the palette as well as the number of items  
that can appear in each row.  
 Refer to the chart Item and Appearance Settings  

(IntelliTools II User's Guide) for options. 
 

 You can experiment with various changes here.  
As you click OK in any area, you will immediately  
see how that change effects the palette within the  
document. You can then keep or change as you'd  
like. For this activity; 
 Layout – no change (unlimited) 
 Display – picture only 
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 Width – no change 
 Colors – change item background color to purple 
 Button Style – push button 
 Font – Arial, 18pt., Plain 

 Click OK to close the Appearance Box. 
 
 
ACTIVITY TRIAL AND EDITING 
 
 Let's try out the activity. In the document window, from the Speech 

menu select Speak Sentences. Click on the apple item. Now click on the 
broccoli. What happened? You may want to make sure that each new 
sentence starts on a new line. Do this we will have to add an enter/return 
command to each item's action list. Also, adding 
Delete Sentence and Read Sentence items to 
the toolbar will give the student more control. 

 
 In the Create menu, select Edit Palette. 

Add Speak Sentence and Delete Sentence 
items to the palette. They can be found in the 
Toolbar Items of the Palette Library. They will 
be added to the end of the palette.  
 

 To add "enter" to each of the items, select the 
first item and click Edit Item. At the Actions 
window, select "Typing" and Add "Type Enter" 
to the list of actions. Make sure it is the last action. 
If you have to move its order, use the Up and Down  
buttons. Click OK. Do this for each item. 
 

 Close out the edit windows and try out the 
activity again, including the new items. 
Make additional changes if you want. When 
you are satisfied, we will save the activity 
as a Document template and create an 
overlay 
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SAVE ACTIVITY AS A TEMPLATE 
 
 Under File, click Save As. In the Template 

window save the activity as "Fruit + Veg". 
Because we will be creating activities for a Food 
unit, let's create a New Subject Area to save it 
in. Click New Subject Area and type in "Foods". 
Click OK.  

 
 Make sure the Subject Area in the Save As 

window indicates "Foods". Click OK to save. 
 
 
 
 
 
 
 
MAKING/EDITING AN OVERLAY 
 
To make an overlay to use with the Fruit + Veg  
Activity,  
 from the IntelliKeys menu select Make Overlay 
 Overlay Maker opens with the pallette items as 

keys 
 Edit the overlay for appearance and access. We 

changed the background color and regrouped the  
keys to separate the command keys from the  
fruits and vegetable keys. We then further  
changed the command keys appearance. 
 

 Save the overlay. Click OK. 
 
 
CHANGE THE APPEARANCE OF AN INDIVIDUAL 
ITEM 
To make the command keys on the palette to also 
appear different from the fruit and vegetable choices 
 In the Create menu select Edit Palettes 
 Highlight Good Food and select Edit Palette 
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 Highlight Read sentence; select Item Appearance 
 You can experiment with various changes here.  

As you click OK in any area, you will immediately  
see how that change effects the palette within the  
document. You can then keep or change as you'd  
like. For this activity; 
 Display – picture only 
 Width – no change 
 Colors – change item background color to lime 
 Button Style – radio button 
 Font – Arial, 18pt., Plain 

 Click OK. Repeat the steps for changes to the Delete sentence item. Your 
palette will reflect the changes.  

 
 
 
CREATE A "FILL IN THE BLANK " ACTIVITY 
 
We will now create a new activity where students will answer 
questions based on their knowledge of fruits + vegetables. To do 
this, we will add text to the current document; change the 
content of the palettes items; and save the activity as a new 
template. 
 
 In the activity document, in the Text menu, select 24 pts. 
 Type the title " Fruits + Veggies"; from the Text menu, 

Center your title. Type a return. 
 Select Left Justify. Type the sentence: "What is a green 

vegetable that grows in pods?" 
 With your cursor next to the question mark, type 2 spaces. In 

the Edit menu, select Insert Answer Field. Move your cursor 
to the end of the Answer Field. 

 Press return 2X. 
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 Type the sentence: "What fruit can be both sweet and 
sour?" Insert 2 spaces and add an Answer Field. Move 
your cursor. 

 Continue creating 2 more questions. 
 
 Select all of the text on the screen  

( -A or Edit/Select All). 
 In the Text menu, select Lock. 
 You will notice that all of the text is underlined. To hide 

the underlining, in the View menu, select highlight Locked 
Text to un-select it. 

 Place your cursor somewhere within the sentence and 
start typing. Notice that the cursor automatically jumps 
to the next unlocked area. This prevents students from 
changing the locked text. 

 
 
EDIT THE GOOD FOOD PALETTE 
 Try using your new activity with the existing  

palette items. What happens? We need to edit  
the actions of the items to include only "insert item"  
as we do not want the sentence to be typed as the answer. 
 

 In the Create men, select Edit Palettes. 
 Highlight the Good Food palette and click Edit Palette 
 Highlight the first item and click Edit Item 
 In the Actions box, Remove all actions except  

for "Insert item". Click OK. 
 Repeat for all of the fruit and vegetable items.  

 
 Because this activity contains only Locked text,  

students will need the action "Read Locked Text" 
instead of "Read Sentence". To change the key's  
actions- edit the actions associated with these items. 
 In the Edit Item Actions box, the Reading List  

includes "Read Locked Text" 
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SAVE AS A NEW TEMPLATE  
 Under File, click Save As. In the Template 

window save the activity as "Food Quiz".  
 
 Make sure the Subject Area is "Foods"  

Click OK to save. 


